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1. INTRODUCTION 
Read&Write 9 Gold is designed to provide 
help to computer users with reading and 
writing difficulties. It can read text aloud 
and help you construct words and 
sentences. It also has many other features, 
such as advanced spell checking, 
document scanning and Internet tools, to 
name but a few. 

1.1 Conventions used in this guide 
The style and conventions in this guide are 
designed to make reading it as clear and 
simple as possible. 

 This is a note. Important additional pieces 
of information that you should be aware of 
are represented as notes. 

 This is a warning. Information that 
you must read and observe are 
represented as warnings. 

 This is a reference. Referrals to 
information in other chapters or sections 
are represented as references. 

Other conventions 
Other conventions include: 
• Instructions that must be followed in 

order are shown in numbered lists 
• Menus and options are represented in 

italics 
• Buttons with text written on them are 

represented in bold, otherwise the 
picture of the button is shown 

• Fields such as text boxes and radio 
buttons are represented in bold italic. 
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2. INSTALLING READ&WRITE 
9 GOLD 
Before you can install Read&Write 9 Gold, 
you must ensure that the computer has: 
• Internet Explorer version 6 or above 
• 512 MB RAM (1 GB RAM 

recommended on Windows Vista) 
• 1.2 GB of free disk space 
• a Pentium 4 1.8 GHz Processor 
• a sound card and speakers 
• a DVD Player (for install purpose only) 
• Windows 2000 SP4 or above. 
To install Read&Write 9 Gold, you insert 
the DVD in the DVD drive. After a moment, 
you see the Read&Write 9 Setup Menu 
dialog box displayed. Click on the Network 

Install (Enterprise) option if you are 
installing Read&Write 9 Gold Enterprise, or 
the Local Install (MSI) option if you are 
installing Read&Write 9 Gold locally. 

Follow the steps in the Microsoft Windows 
installation wizard.  

If the Read&Write 9 Setup Menu dialog box 
does not appear: 
1. Select the Run option from the Start 

menu. 
2. Browse to the location of the DVD 

drive and locate the AutoRun.exe. 
3. Click on the OK button. 

2.1 Activating the software 
When Read&Write 9 Gold starts up for the 
first time you will see the Read&Write 
Activation dialog box. 
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Activating Read&Write 9 Gold ensures that 
Texthelp can contact you about any 
updates to the software that become 
available in the future. 
To activate Read&Write 9 Gold: 

1. Enter your serial number. 
2. Enter your name and email address. 
3. If you have purchased International voices 

from Texthelp, enter the code supplied to 
you in the International Voices Code field 
and then click on the Activate button to 
activate the voices. 

4. If you want to allow Texthelp to gather 
usage information to help them improve 
subsequent versions of Read&Write Gold, 
select the check box at the bottom of the 
dialog box. 
5. Click on the OK button to activate the 

software.  

3. INTRODUCING 
READ&WRITE 9 GOLD 

You have many facilities available to you in 
Read&Write 9 Gold. The majority of them 
are covered in this user guide. If you want 
more information on other facilities which 
are not included in this guide, refer to the 
online help. 

 Refer to ‘Setting up the system’ in the 
online help for information on setting up 
and changing how facilities work. 

3.1 Using the toolbar 
Figure 3-1 labels all of the buttons on the 
Read&Write 9 Gold toolbar.  
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Figure 3-1 The Read&Write 9 GOLD toolbar
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You may also see the following Study 
Skills buttons: 

•  – Highlight color button 

•  – Clear highlights button 

•  – Collect highlights button 

•  – Summary button. 
You can: 
• position the toolbar anywhere on the 

screen by dragging and dropping it 
onto the appropriate position. If you 
dock the toolbar, you can undock it by 
clicking on the  button 

• access the functions on the toolbar 
using hotkeys. You can set up your 
own hotkeys 

 For information on setting up hotkeys, 

refer to ‘Choosing General Options’ in 
the online help. 

• customize the toolbar 
• load your personal settings 
• view any hidden buttons that cannot 

fit on the toolbar by clicking on . 
Customizing the toolbar 
To customize the toolbar: 

1. Click on the  drop down list, select 
the Current Toolbar option and then 
select the type of features you want to 
display. 

Alternatively, click on the  button 
until the toolbar of your choice is 
displayed. The tooltip of this button 
indicates which toolbar is displayed. 
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 For information on setting up which 
buttons you see when you select any of 
the options and to customize the toolbar 
further, refer to ‘Choosing General 
Options’ in the online help. 

2. Click on the  drop down list and 
select any of the following: 

• Show tooltips on toolbar 
• Show windows behind docked toolbar. 

Loading your personal settings 
To load your personal settings, click on 

the  drop down list and select 
Load my settings. 
You can save your personal settings to a 
location of your choice, e.g. a folder on 
your hard drive or on a memory stick.  
To save your personal settings, click on 

the  drop down list and select 
Save my settings. 
To load your personal settings: 

1. Click on the  drop down list and 
select Load my settings. 
The Browse For Folder window is 
displayed. 

2. Browse to the appropriate drive on your 
computer and then click on OK to load 
your personal settings. 

4. READING TEXT 
This section explains how to use 
Read&Write 9 Gold to read text. It also 
explains how to convert text into sound 
files. 



Read&Write 9 Gold Reading Text 

 7   

4.1 Reading text using the toolbar 
 You can also read text within OpenOffice 

Writer (3.0) using dual color highlighting. 
To read text using the toolbar: 

1. Click on the  drop down list, and 
select Read by word, Read by sentence 
or Read by paragraph. 

2. Select the Automatically read next block 
of text from this menu if you would like to 
set up the system to automatically read 
aloud the next word, sentence or 
paragraph. To disable this facility, select 
this option again. 

3. Click on one of the following buttons: 

•  – place the cursor on the word, 
sentence or paragraph, then click on this 
button 

•  – to move speech back click on 
this button 

•  – to move speech forward click on 
this button. 

The system reads the text aloud. If 
required, click on either of the following 
buttons at any stage: 

•  – click on this button to pause 
reading, then click on it again to 
resume 

•  – click on this button to stop 
reading the text aloud. 

4.2 Reading text as you type 
To read text as you type: 

1. Click on the  drop down list and select 
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Speech Options. You see the Speech 
options window. 

2. Click on the AUTOREAD tab and then 
select the I would like to use speak as I 
type check box. 

3. Select any combination of the Speak on 
each letter, Speak on each word, and 
Speak on each sentence check boxes 
and then click on OK. 
You can disable/enable the Speak As I 
Type facility more easily by clicking on 

the  drop down list and selecting the 
Speak As I Type option. 

4.3 Activating Screen Reading  
You can instruct the system to read aloud 
information on most objects, including 
icons, toolbars and buttons, when you 
hover your mouse over them. 

To activate the Screen Reading facility: 

1. Click on the  drop down list and select 
Speech Options. You see the Speech 
options window. 

2. Click on the AUTOREAD tab and then 
select the I would like to use screen 
reading check box. 

3. Select the types of information you want 
the system to read by selecting the 
appropriate check boxes from the list at 
the bottom of the window and then click 
on OK. 
The system will now read out information 
on the selected object types when you 
place the cursor over them or tab to 
them. 
You can disable/enable the Screen 
Reading facility more easily by clicking 
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on the  drop down list and selecting 
the Use Screen Reading option. 

4.4 Reading text on web pages 
To read text on a web page: 

1. Click on the  drop down list and select 
Web Highlighting. 

2. Hover your mouse over an area of text 
on a web page until it becomes 
highlighted. The system reads aloud the 
highlighted text. 
You can then use the Speech buttons on 
the Read&Write 9 Gold toolbar. 
To read text in the Firefox browser (3.0) 

select the text and click on the  
button. Click on OK when prompted to 
install the plug-in. 

4.5 Using the Text Reader window 
You can use the Text Reader window to 
display text from text files, from the 
clipboard, or from Screenshot Reader. 
You can then use the Speech buttons on 
the Read&Write 9 Gold toolbar as 
required. 

 Refer to ‘Using Screenshot Reader’ 
on page 11 for more information. 

To display a text file in Text Reader: 

1. Click on the  drop down list and select 
Text file from the Open in Text Reader 
menu. You see the Select file to open 
window. 

2. Browse to the location in the directory 
where the text file is located, and then 
click on Open.  
To display text from the clipboard in Text 
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Reader: 
3. Highlight the text in your document. 
4. Right click on the highlighted text and 

select Copy from the pop-up menu. 

5. Click on the  drop down list and select 
from clipboard from the Open in Text 
Reader menu.  

4.6 Using the Speech Maker  
You use the Speech Maker facility to 
convert text in any document or program 
into speech, which can then be 
converted into a sound file. 
To convert text to sound: 

1. Highlight the text you want to convert. 

2. Click on the  button on the toolbar. 

Alternatively, click on the  drop down 

list and select Speech Maker from the 
Speech Maker menu. You see the first 
window in the Speech Maker facility, 
displaying the text you selected in step 1. 

3. Click on Next. 
4. Alter the current voice settings until you 

are happy with the settings. Click on the 

 button to test the new voice. 
5. Click on Next. 
6. Click on Save As and browse to the 

folder in the directory in which you want 
to save the sound file, then click on 
Save, or if you have an MP3 player 
attached to your computer, select the 
MP3 drive. 

7. Select the appropriate File Format radio 
button to specify the type of sound file 
format you want to create. 

8. You can customize the MP3 and WMA 
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settings by clicking on the Options 
buttons. 

9. Click on Finish to create the new sound 
file. 
The next time you want to convert text 
into sound using the settings you have 
just configured: 

10. Highlight the text you want to convert into 
a sound media file. 

11. Click on the  drop down list and select 
Create file using last saved settings from 
the Speech Maker menu. 

4.7 Using Screenshot Reader 
You use Screenshot Reader to read 
aloud any text on the screen. In 
particular, it can read aloud text used in 
images or any application, even if this 
text is not accessible, for example, flash. 

To use Screenshot Reader to read text: 

1. Click on the  drop down list and 
specify whether or not you want to use 
Text Reader to read aloud the text. If you 
do not select this option, the text will be 
read aloud in a separate window. 

2. Click on the  button. Your cursor now 

looks like this:  
3. Select the area of text you want to read 

aloud. 
Read&Write 9 Gold reads the text aloud 
in a separate window/Text Reader. 
Importing text into MS Word 
You can also import text from a 
screenshot into MS Word, therefore 
allowing you to use the other Read&Write 
9 Gold facilities on the text. 
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To import text into MS Word: 

1. Click on the  drop down list and 
select Screenshot to MS Word. 

2. Click on the  button. Your cursor now 

looks like this:  
3. Select the area of text you want to 

import. 
The text is displayed in a new MS Word 
document. 

5. SPELL CHECKING 
You use the Spell Checker to spell check 
selected words, your entire document or 
as you type. 

5.1 Spell checking selected words 
To spell check selected words: 
1. Select the word that you want to 

check. 

2. Click on the  button on the 
toolbar. If the selected word is: 

• correctly spelt, nothing happens 
• incorrectly spelt, you see the Spell 

Helper window (Figure 5-1). 
From the Spell Helper window, you: 

3. Select the appropriate radio button 
depending on whether you want to view 
nouns, verbs, adjectives or adverbs. To 
view all word types, select the All radio 
button. 
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Figure 5-1 The Spell Helper window
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4. Select a word from the Word list box. A list 
of alternative words and their meanings is 
displayed in the Alternative Meanings list 
box. 

5. Choose from the following options: 
• change the mis-spelt word to the selected 

word by clicking on Change word  
• change the mis-spelt word throughout your 

document by clicking on Change all  
• add the selected word to your custom 

dictionary by clicking on Add to custom 
dictionary 

• add a mis-spelt word to the auto correct file 
by clicking on Add to auto correct  

• ignore the mis-spelt word by clicking on 
Ignore word. 

6. Select the Move to next error check box 
to automatically move to the next mis-spelt 
word after analyzing the current word. 

5.2 Spell checking your 
document 

1. To spell check your document: 

2. Click on the  button on the toolbar.  
You see the Spell Helper window 
(Figure 5-1) and the first suggested mis-
spelt word in the Original Word text 
box. 

3. Follow steps 3 to 5 in the previous 
section.  

5.3 Spell checking as you type 
To spell check as you type, click on the 

 drop down list and select Spell As I 
Type. 
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6. USING WORD PREDICTION 
You can use the Word Prediction facility to 
access a list of words that will complete the 
one that you are currently typing. Word 
Prediction will also try to predict your next 
word as you finish typing a word. 
To use the Word Prediction facility: 

1. Click on the  button on the toolbar. You 
see the Prediction window. This window 
displays a list of predicted words from 
which you can select. Homophones are 

marked by the  symbol. Prediction 
accuracy for each word is shown by:  

• a green indicator or circle if it is highly 
likely. This is based on probability and 
grammatically accurate based on word 
triplets 

• an orange indicator or a square if it is 
likely. This is based on probability and 
grammatically accurate based on word 
pairs 

• a black indicator or a triangle if it is least 
likely. This is based on probability only. 

2. If required, place the cursor over a 
predicted word, and then click on the 

 button. You see the Dictionary 
window (Figure 7-1) listing definitions 
for the predicted word. 

 Refer to Section 7, ‘Using the 
Dictionary’, for information on using the 
Dictionary window. 

3. Right click on the Prediction window 
and select the prediction options. 

4. Complete one of the following 
depending on the prediction options you 
selected in step 3: 
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• if you selected the Speak the word when it 
is clicked option, click on a word to hear it 
read aloud 

• if you selected the Type the word when it is 
clicked option, click on a word to insert it 
into the document 

• press the appropriate function key to select 
the word that you want to insert.  

6.1 Creating your own prediction 
files 
You can set up your own prediction files 
and use them to enhance the Prediction 
facility. For example, you may have a text 
file containing text relating to biochemistry 
which contains words that are not present 
in the default Prediction file. If you add this 
text, the Prediction facility will become 
better equipped to provide you with 

predictions relating to biochemistry. 
To create your own prediction files: 
1. Highlight the text you want to use to 

create a prediction file and then copy it 
to the clipboard. 

2. Click on the  drop down list and 
select Create prediction word bank from 
the clipboard. The Create a new 
prediction word bank dialog box is 
displayed. 

3. Enter a unique name and description for 
the new prediction file in the fields 
provided.  
The text you copied to the clipboard is 
displayed at the bottom of the dialog 
box. If required, you can edit this text 
from within this dialog box. 

4. Click on OK. A message box is 
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displayed explaining that the file has 
been saved in your User Setting’s 
folder. 

7. USING THE DICTIONARY 
You use the dictionary to look up different 
meanings for selected words. You can 
configure the dictionary to display: 

• basic definitions – lists meanings and word 
inflections  

• advanced definitions – allows you to 
conduct advanced dictionary functions and 
displays synonyms 

• web definitions – lists meanings in the 
Dictionary.com website. 
This chapter also helps you use the Word 
Wizard. 

7.1 Finding basic definitions 
To find basic definitions: 
1. Make sure the Basic Definitions option 

is selected in the  drop down list. 
2. Highlight the word in the text you want 

to check. 

3. Click on the  button on the toolbar. 
You see the Dictionary – Basic 
Definitions window (Figure 7-1). 
The word you specified is shown in the 
Original Word text box. 

4. Select the appropriate radio button to 
specify whether you want to look up 
meanings for nouns, verbs, adjectives, 
or adverbs for the word. To look up all 
word types, select the All radio button. 
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Figure 7-1 The Dictionary – Basic Definitions window 
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You can also use the Dictionary window for 
the following functions: 

• replace the original word with a different 
word. To do this, click on one of the 
meanings displayed in the Dictionary 
Meanings list box, then click on a word in 
the Inflections list box and then click on 
Replace 

• conduct a new dictionary search. To do 
this, enter the new word in the Original 
Word text box and then click on Search  

• browse through the different word searches 
you have conducted using the Browse 
buttons. When you close the Dictionary 
window, the browse history will clear. 

7.2 Finding advanced definitions 
You may need to narrow down a search if 
the word is used in many different ways.  

To do this: 
1. Make sure the Advanced Definitions 

option is selected from the  drop 
down list. 

2. Highlight the word in the text you want 
to check. 

3. Click on the  button on the toolbar. 
You see the Dictionary – Search All 
Definitions window. The word you 
specified is shown in the Original Word 
text box.  

 This window is similar in appearance to 
the Basic Definitions window. 

4. Click on Advanced to view a list of 
search types. 

5. Click on a search type. The list of 
alternative meanings relating to the 
search item you selected is displayed in 



Read&Write 9 Gold Using the Dictionary 

 2 0   

the Dictionary Meanings list box. 
6. You can now use the other dictionary 

functions as described on page 17. The 
only difference is that you can replace the 
original word with a synonym instead of a 
word inflection. A list of synonyms is 
displayed in the Synonyms list box. 

7.3 Finding web definitions 
To find web definitions: 

1. Make sure the Web Definitions option is 

selected from the  drop down list. 
2. Highlight the word in the text you want to 

check. 

3. Click on the  button on the toolbar. 
The Dictionary.com website is displayed. 
Your specified word and definition(s) are 

listed. 

7.4 Using the Word Wizard 
You can use the Word Wizard to: 
• help you find words or phrases that you 

cannot remember 
• search for words using opposites or 

other relationships. For example, if you 
search using the phrase 'parts of a car', 
the Word Wizard will list words like 
throttle, tailpipe and fender.  

To use the Word Wizard:  
1. Highlight the word you want to look up. 

2. Click on the  button on the toolbar. 

Alternatively, click on the  drop 
down list and select Word Wizard. You 
see the first window in the Word Wizard.  
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3. Select the appropriate radio button to 
specify whether the word is a noun, verb, 
adjective, or adverb, and then click on 
Next.  

 If it is obvious that the specified word is a 
certain type of word, for example, a noun, 
the first window is not displayed. 
You see the next window in the Word 
Wizard. 

4. Select the synonyms list and meaning that 
corresponds to the word you are searching 
for and then click on Next.  

5. Click on one of the Advanced Search 
radio buttons depending on the type of 
search you want to conduct, for example, 
you can look for words that are opposite to 
the words in the specified synonym list. 

6. Click on Next to continue.  

7. Click on a word or phrase in the 
Related Words or Phrases list box to 
view a list of related synonyms, i.e. click 
on a word or phrase from the list on the 
left. 

8. Select the word you want to insert into 
your document, from the Synonyms list 
box. 

9. Click on Replace to insert the specified 
word. 

8. USING THE 
HOMOPHONES 
FACILITY 

You can use the Homophones facility to 
view descriptions of like sounding words to 
help you ensure you have typed the correct 
word.  
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 You can only highlight homophones when 
using MS Word. 
To activate the Homophones facility either: 

• click on the  button on the toolbar 

• click on the  drop down list and select 
Show Homophones in MS Word.  
All homophones within the text are 
highlighted. 
To deactivate the Homophones facility 
either: 

• click on the  button on the toolbar 

• click on the  drop down list and select 
Hide Homophones in MS Word. 
To use the Homophones facility:  

1. Click on the  button on the 
toolbar. 
If the document is in MS Word, all 
homophones within the document are 
highlighted. You see the Same 
Sounding Words window (Figure 8-1). 

2. Select a word from the Homophones 
list box. A list of meanings is displayed 
in the Word Meaning list box. 

3. Choose from the following options: 
• ignore the word highlighted in the text 

by clicking on Ignore 
• always ignore the word highlighted in 

the text by clicking on Always Ignore  
• replace the word in the text with the 

selected word by clicking on Replace  
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Figure 8-1 The Same Sounding Words window
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4. Select the Move to next homophone 
check box to automatically continue to 
the next homophone after you have dealt 
with the current one. 

 Refer to ‘Editing the Homophones facility’ 
in the online help for information on 
editing homophone groups. 

9. USING THE 
CALCULATORS 
In this section, you will learn how to use 
the Read&Write 9 Gold Standard and 
Scientific Calculators. 

9.1 Using the Standard Calculator 
You can use the Standard Calculator to 
perform calculations in much the same 
way as you would with the MS Windows 

calculator. However, the Standard 
Calculator has several added features, 
which are discussed in the following 
sections.  
To access the Standard Calculator, click 

on the  drop down list and select 
Standard Calculator. The next time you 
want to access the Standard Calculator, 

you will only have to click on the  
button. The Standard Calculator is 
displayed. 

9.2 Changing the appearance 
of the calculators 

You alter the appearance of the 
calculators using the View menu. You 
can change the calculator 
background/foreground color by selecting 
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the Background Color/Foreground Color 
option, then selecting a color from the 
color palette. 
In the Standard Calculator you can also 
use the View menu to:  

• change the size of the calculator by 
selecting Small, Medium or Large 

• change the calculator input display and 
audit trail fonts by selecting the Font 
option, then selecting the appropriate font 
options from the Font window. 
To revert to the default settings, click on 
the View menu and select Reset 
Defaults. 

9.3 Selecting calculator speech 
options 
You can specify how you want 
Read&Write 9 Gold to read aloud when 

you perform calculations using the 
Standard and Scientific Calculators. 
To select calculator speech options, click 
on the Speech menu and then select one 
of the following options: 
• Speak on Mouse Over – you will hear 

the name of the button read aloud 
when you hover the mouse over it 

• Confirm on Equals – you will hear the 
whole calculation read aloud after you 
click on equals 

 This option is not available on the 
Scientific Calculator. 

• Speak on Click – you will hear the 
name of the button read aloud when 
you click on it 

• Audible Button Click – you will hear 
an audible click when you click on a 
button 
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• No Sound on Click – you will hear no 
sound when you click on a button. 

10. SCANNING 
The Read&Write 9 Gold Scanning facility 
allows you to scan documents directly to 
Word, Internet Explorer or to a PDF file. It 
also allows you to acquire images from a 
digital camera. Before you perform a 
scan, you can specify the scanner 
settings, where you want to save 
scanned images and how you want them 
to look. 

10.1 Configuring scanning options 
To configure scanning options, click on 

the  button and select Scanning 
Options. You see the Scanner Settings 

window. 
You use this window to configure: 
• output settings 
• scanner settings. 
Configuring output settings 
You can specify where you want to save 
scanned images and how you want them 
to look, using output settings. To do this: 

1. Click on the Output Settings tab. 
2. Specify where you want to save scanned 

images by selecting one of the following 
radio buttons: 

• Temporary file/folder – saves images to 
a temporary file/folder created by 
Read&Write 9 Gold 

• Ask for a filename every time – allows 
you to specify the filename and directory 
in which you want to save scanned 
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images each time you scan a document 
• Choose a location to save to – allows 

you to specify the directory in which you 
want to save all scanned images. 
If you select this radio button, click on 
Browse and browse to the location in the 
directory where you want to save your 
images. Then enter a prefix for each 
saved image in the Filename prefix text 
box. 

3. Select either of the following radio 
buttons from the PDF output settings 
section, depending on how you want your 
scanned images to look if they are 
scanned to a PDF document: 

• Fully Formatted PDF document  – will 
contain font information 

• Image on text – will contain an image 
with embedded text. This option 

produces a more accurate representation 
of the scanned document. 

4. Select the Retain full formatting with 
graphics check box in the Word output 
settings section if you want images, 
scanned to Word, to contain images and 
text with formatting. If you deselect this 
checkbox, the Word document will 
contain only text. 

5. Select either of the following radio 
buttons from the HTML output settings 
section, depending on how you want your 
scanned images to look if they are 
scanned to an Internet Explorer file: 

• Retain Graphics in final output – will 
contain images and text with formatting 

• Use simple HTML, without graphics 
– will contain only text. If you select this 
option, specify if you want to use your 
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own font size, style and color and 
background color by selecting the Use 
custom font and color settings check 
box. Click on HTML Options to select 
the font and colors. 

6. Click on OK. 
Configuring scanner settings  
You can specify how you want to scan 
documents using scanner settings. 
Before you can do this, you must be 
using TWAIN mode. Your scanner must 
also be connected to the system, as it is 
necessary to communicate with the 
scanner to accurately configure settings. 
To configure scanner settings: 

1. Click on the Scanner tab (Figure 10-1). 
The options you can see depend upon 
the type of scanner you are using. 

2. Select the scanner you want to use from 

the Scanner drop down list. 
3. Select the Hide your scanners 

configuration dialogs check box if you 
do not want to use your scanner’s 
configuration screens. 

4. Specify the resolution at which you want 
to scan documents by selecting either the 
150 DPI or the 300 DPI radio button from 
the Image Resolution section. 

 150 DPI is faster than 300 DPI. It is 
recommended that 300 DPI is used for 
OCR scanning. 

5. Select one of the following radio buttons 
from the Multipage Settings section: 

• Single pages – allows you to scan one 
page at a time 
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 Figure 10-1 Scanner Settings window – Scanner tab
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• Multiple pages (with prompt) – allows 
you to set up the Scanning facility to ask 
you if you want to scan more pages after 
each scan has been completed 

• Multiple pages (countdown) – allows you 
to scan multiple pages at a time. You can 
then enter the number of seconds you want 
to leave between each scan, in the 
Countdown text box 

• Multiple pages (with ADF) – allows you to 
scan multiple pages at a time using 
Automatic Document Feeder (ADF).  

6. Select the Enable duplex check box if you 
want to scan on both sides of the paper 
and your scanner allows you to do this. 

7. Specify the level of color required for the 
scanned document by selecting one of the 
Monochrome, Grayscale or Full color 
radio buttons from Color Settings. 

8. Move the Brightness and Contrast 
scales as required. Select the Auto 
check box if you want the system to 
adjust the brightness automatically. 

 Contrast increases the difference in 
shading between areas. 

10.2 Scanning documents 
To scan a document: 
1. Place the document you want to scan 

into the scanner. 
2. Select the appropriate option from the 

 drop down list depending on 
whether you want to scan to a Word, 
Internet Explorer or PDF file. For 
example, select Scan to HTML if you 
want to scan to Internet Explorer. 
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3. Click on the  button on the toolbar.  
The document is scanned and opened in 
the application of your choice. 
You can also scan from a saved image file, 
by selecting the Scan from File option from 

the  drop down list. 

10.3 Scanning from a digital camera 
To scan from a digital camera: 

1. Take the required photo using your digital 
camera. 

2. Connect your camera to your computer 
using your USB cable. 

3. Click on the  drop down list and select 
either of the following options: 

• Scan from WIA – select this option if 
your camera is WIA compatible. 
The MS Windows WIA Browse dialog 
box is displayed. Select the photo you 
want to scan. 
If there are two devices attached to your 
computer, for example, your camera 
and the scanner, the Select Device 
dialog box is displayed. Select your 
camera and then click on OK. You can 
browse for the photo you want to scan. 

• Scan from file – select this option if your 
camera is not WIA compatible but 
instead opens in Windows Explorer. 
This option allows you to browse for the 
photo you want to convert. 
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11. USING THE FACT FOLDER 
The Fact Folder is a desk research tool, 
which allows you to capture text and 
graphics from any application and organize 
them into categories that can aid you with 
your study. 

11.1 Capturing text using the toolbar 
You can capture and save text using the 
Read&Write 9 Gold toolbar or the Fact 
Folder window. This section deals with the 
former. 
To capture and save text: 

1. Highlight the text you want to capture and 

then click on the  button on the toolbar.  

Alternatively, copy the text to the 

clipboard, click on the  drop down 
list and select the Add Clipboard 
Contents option. You see the Fact 
Details window (Figure 11-1). 

2. Complete the following fields: 
• Title – enter a name for the item 
• Date – the current date is displayed by 

default. Click on the drop down list to 
use the Calendar to select a different 
date 

• Author – enter the name of the author 
of the item  



Read&Write 9 Gold Using the Fact Folder 

 3 3   

 

 
Title text box 

 
Date drop down list 

 
Author text box 

Sources list box 

  
Add Source 
button 

 
Delete 
Source 
button 

 
Browse for 
Category 
button 

Category text box 

Description text box 

Figure 11-1 Fact Details window
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• Sources – the website addresses of any 
web pages you have open are 
automatically added to the Sources list 
box. If you captured the item from a 
different source, you must add the location 
of the document to the Fact Folder. This is 
important because at some stage you may 
need to refer to the original document. 
Select the check boxes of the sources from 
which the item originated. 
To add a different source, click on the  
button and locate the document in the 
Browse for a Source dialog box. 
To remove a source from the list, select the 
source and then click on the  button. 

• Category – click on the  button to 
access the Categories window, which 
allows you to specify to which category you 
would like to add the item 

 For more information on the Categories 
window, refer to ‘Managing categories’ 
on page Error! Bookmark not 
defined.. 

• Description – enter a statement to help 
identify the item. 

3. Click on OK to save the new item to the 
Fact Folder. 

11.2 Capturing graphics using 
the toolbar 

You can capture and save graphics using 
the Read&Write 9 Gold toolbar or the Fact 
Folder window. This section deals with the 
former. 
To capture and save a graphic: 
1. Open the web page containing the 

graphic. 



Read&Write 9 Gold Using the Fact Folder 

 3 5   

2. Click on the  drop down list on the 
toolbar and select Add Web Image.  

3. The Texthelp Web Hover popup is 
displayed at the bottom right-hand corner 
of your screen. Hover your mouse over the 
images on the website to see them appear 
in the popup. 

4. Click on the image you want to capture. 
You see the Fact Details window (Figure 
11-1). 

5. Complete steps 2 and 3 on page 32. 

11.3 Reviewing facts 
You can review the facts you have 
collected using the Fact Folder window 
(Figure 11-2). You access the Fact Folder 

window by clicking on the  drop down 
list and selecting the Review Facts option.  

You can reorder the facts by clicking on the 
column titles, and adjusting the column 
widths using the double arrowed cursor. 
If you select a fact, a preview of the fact is 
shown in the Preview pane. If you cannot 
see this pane, click on the Tools menu and 
select Preview Pane. 

11.4 Using the Fact Folder 
window 

You can use the Fact Folder window to 
review all of the facts you have collected 
and add additional facts and graphics. 
To view facts within different categories, 
click on the Category drop down list and 
select the category for which you want to 
view facts. 
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Figure 11-2 Fact Folder window
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 You can select and deselect all facts by 
clicking on the Tools menu and selecting 
either Select All Facts or Deselect All 
Facts. 
Displaying and editing the contents 
of facts 
If you select a fact, a preview of the fact is 
shown in the Preview panel. 
To display and edit the contents of a fact: 

1. Select the fact you want to view and then 

either click on the  button on the 
toolbar or click on the Facts menu and 
select Display Contents. Alternatively, 
double click on the fact you want to view. 
You see the Displaying Fact window, which 
allows you to view the fact contents. 

2. If required, edit the fact contents and then 
click on Apply to save the changes.  

Editing fact properties 
To edit the properties of a fact: 
1. Select the fact you want to edit and then 

either click on the  button on the 
toolbar or click on the Facts menu and 
select Edit Information. You see the 
Fact Details window (Figure 11-1). 

2. Edit the fields as required. 
 Refer to steps 2 and 3 on page 32 for 

information on completing these fields. 
Capturing text 
To capture and save text: 
1. Highlight the text you want to capture 

and then click on the  button on the 
toolbar. Alternatively, copy the text to 
the clipboard, click on the Tools menu 
and select Add Clipboard Contents.  
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You see the Fact Details window (Figure 
11-1). 

2. Complete steps 2 and 3 on page 32. 
Capturing graphics 
To capture and save a graphic: 

1. Open the web page containing the graphic. 
2. Click on the Tools menu and select Web 

Hover. The Texthelp Web Hover popup is 
displayed at the bottom right-hand corner 
of your screen. Hover your mouse over the 
images on the website to see them appear 
in the popup. 

3. Click on the image you want to capture. 
You see the Fact Details window (Figure 
11-1).  

4. Complete steps 2 and 3 on page 32. 
Capturing files 
You can add files to the Fact Folder, e.g. 

MS Word documents. 
To add a file: 
1. Open Windows Explorer and locate the 

file you want to add to the Fact Folder. 
2. Click and hold down your left mouse 

button on the file and drag and drop it 
onto the Fact Folder. You see the Fact 
Details window (Figure 11-1). 

3. Complete steps 2 and 3 on page 32. 
 You can access this file from within the 

Fact Folder by clicking on the  
button or clicking on the Facts menu 
and selecting Execute. 

Capturing URLs 
To add a URL to the Fact Folder: 
1. Open your browser window and then 

open the webpage you want to add. 
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2. Click and hold down your left mouse button 
on the Internet Explorer icon displayed 
beside the URL in the Address text box, 
as shown below: 

 
 

3. Drag and drop the icon onto the Fact 
Folder. You see the Fact Details window 
(Figure 11-1). 

4. Complete steps 2 and 3 on page 32. 
 You can access this URL from within the 

Fact Folder by clicking on the  button or 
clicking on the Facts menu and selecting 
Execute option. 
Opening files and URLs in their 
native application 
If you have added a file/URL to the Fact 

Folder, you can open it in its native 
application from within the Fact Folder. 
To open a file/URL in its native application: 
1. Click on the fact containing the file/URL. 

2. Click on the  button or click on the 
Facts menu and select Execute. You 
see the file/URL displayed in it’s native 
application. 

Deleting facts 
To delete a fact, you select the fact you 
want to delete, and then click on the Facts 
menu and select Delete. 
To delete several facts at once, select the 
check boxes beside the facts you want to 
delete and then click on the Tools menu 
and select Delete Selected Facts. 
Managing categories 
You use the Categories window to manage 

Internet Explorer icon
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categories containing facts and to specify 
to which categories you would like to add 
facts. 
 You can only do the latter function if you 
have accessed this window from the Fact 
Details window, i.e. if you are entering fact 
details. 
To access this window, click on the Tools 
menu and select Manage Categories. You 
can now: 

• add a new category – click on Add, enter a 
name for the category in the Edit Category 
Name dialog box and then click on OK  

• edit a category – select the category from 
the Category List, click on Edit, enter a 
new name for the category in the Edit 
Category Name dialog box and then click 
on OK 

• delete a category – select the category 
from the Category List and then click 
on Delete 

• specify to which categories you would 
like to add facts – select the check 
boxes beside the appropriate 
categories.  

Exporting facts 
You can export a category of facts to an 
HTML web page or an MS Word 
document. 

 For a more direct way of exporting all 
facts to an MS Word document, click on 

the  button or click on the Tools 
menu and select Export All to Word. 
To export facts: 

1. Select the category of facts you want to 
export, from the Category drop down. 
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2. You can now: 
• select the check boxes of the facts you 

want to export, click on the Tools menu 
and select Export Selected Facts 

• click on the Tools menu and select the 
Export All option. 
You see the export window. 

3. Select the type of export you want: 
• Web Export – creates a new HTML web 

page based on the facts you have 
selected. The HTML page will list all of the 
selected facts under the same headings as 
the Fact Folder, e.g. Name and Description 

• Word Export – creates a new MS Word 
document based on the facts you have 
selected. The document will list all of the 
selected facts under the same headings as 
the Fact Folder, e.g. Name and 
Description. 

4. Click on Browse to display the Select 
Export File dialog box, specify where 
you want to save the file, enter a file 
name and then click on Save. 

5. Click on OK. 
Read&Write 9 Gold automatically 
creates the HTML page or MS Word 
document and displays it in the 
appropriate application. 

12. USING THE FACT 
MAPPER 

Fact Mapper helps you simplify thought 
processes by utilizing the mind’s ability to 
understand and remember visual 
information. 
Fact Mapper provides an online graphical 
user interface that allows you to add new 
information elements to a map. 
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To access the Fact Mapper, click on the 

 button. You see the Fact Mapper 
open in a new browser window. 
Figure 12-1 explains all the buttons in the 
Fact Mapper window. These have been 
split into the File menu toolbar buttons and 
the Fact Map menu toolbar buttons.  

 Make sure you save your fact map 
before closing the Fact Mapper or you 
will lose your work. 

 You will know when you have selected a 
fact in the Fact Mapper when you see it 
surrounded by a dotted line. 
When you first access the Fact Mapper, as 
soon as you attempt to use any of the 
facilities you will see a message box asking 
you if you want to allow this webpage to 
access your Clipboard. Click on the Allow 
access button to enable this facility. 

12.1 Changing the appearance of 
the Fact Mapper window 

You can change the coloring of the Fact 
Mapper window. This may help you to see 
the buttons and options more clearly. 
To change the color of the window, click on 
the appropriate Theme button: 

 
These buttons are located at the top right-
hand corner of the window. 

12.2 Creating new fact maps 
To create a new fact map, click on the File 

menu and then click on the  button. 
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You can select the zoom level at which 
you want to view the fact map, by clicking 
on the  and  buttons at the top 
right-hand-side of the Fact Mapper 
window. 

12.3 Opening fact maps 
To open an existing fact map: 

1. Click on the File menu and then click on 

the  button. You see the Open File 
Webpage dialog. 

2. Click on the Browse button. The Choose 
file dialog box is displayed.  

3. Select the fact map you want to open and 
then click on Open. 

4. Click on the OK button. 

12.4 Saving fact maps 
To save a fact map: 

1. Click on the File menu and then click on 

the  button. You see the File 
Download dialog box. 

2. Click on the Save button. The Save As 
dialog box is displayed. 

3. Browse to the folder in the directory in 
which you want to save the fact map, 
enter a name for it in the File name text 
box and then click on Save.  

4. The Download complete dialog box is 
displayed. Click on Close. 

12.5 Adding new facts 
To add a new fact to the fact map, click 
on the Fact Map menu and then click on 
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the  button.  
The new fact is displayed in the main 
work area. You can now add more facts 
to the fact map and link them 
appropriately. 

12.6 Adding notes to facts 
To add a Post It note to a fact: 

1. Select the fact to which you want to add 
the note. 

2. Enter the text you want to associate with 
the fact in the text area at the bottom of 
the Fact Mapper window. 

3. Click on the  button. The Post It note 
is added to the fact. It is represented by 
the  icon. 
You can delete a Post It note from a fact 

by selecting the fact and then clicking on 

the  button, or right clicking on the fact 
and selecting Delete Post It from the 
popup menu. 

12.7 Adding facts from the 
Image Library 

You can use images from the Image 
Library to represent facts in your fact 
map.  
To select an image from the Image 
Library: 

1. Enter the name of the image you want to 
search for in the Search textbox at the 
bottom right-hand-side of the Fact 
Mapper window. 

2. Click on the Go button. The Search tab 
expands to display the list of images that 



Read&Write 9 Gold Using the Fact Mapper 

 4 6   

match your search word.  
3. You can now:  
• click and hold down your left mouse 

button on the image and drag and drop it 
onto the main work area in the Fact 
Mapper. You can replace the image on 
an existing fact element, by dropping the 
image directly on top of the element 

• right click on the image and then click on 

Copy Image. Click on the  button in 
the Fact Mapper window. If you want to 
change one of the existing facts, select it 

first and then click on the  button. 
You can change a fact image back to the 
way it was before you added the image 
by right clicking on the fact and selecting 
Restore Original Image from the popup 
menu. 

12.8 Deleting facts 
To delete a fact from the fact map: 

1. Click on the fact in the main work area. 
2. You can now: 

• click on the  button 
• press the Delete key on your 

keyboard. 

12.9 Adding links 
To add a link between two facts: 

1. Click on the fact from which you want to 
make the link. 

2. Click on the  button. The selected fact 
is highlighted. 

3. Click on the fact to which you want to 
make the link. 
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Alternatively: 
1. Right click on the fact from which you 

want to make a link and select the Add 
Link option from the popup menu. 

2. Right click on the fact to which you want 
to make the link and select the Complete 
Link option from the popup menu. 

12.10 Deleting links 
To delete a link between two facts: 

1. Click on the fact from which you want to 
remove the link.  

2. Click on the  button. The selected 
fact is highlighted. 

3. Click on the fact to which you want to 
remove the link. 
Alternatively: 

4. Right click on the fact from which you 

want to delete a link and select the 
Delete Link option from the popup menu. 

5. Right click on the fact to which you want 
to remove the link and select the 
Complete Delete Link option from the 
popup menu. 

12.11 Printing a fact map 
To print the fact map you are currently 
working with: 

1. Click on the File menu and then click on 

the  button. The Print dialog box is 
displayed. 

2. Select the printer to which you want to 
print the Fact Map and then click on 
Print. 
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12.12 Editing the fact title 
To edit the title of a fact you can: 

• double click on it 
• right click on it and select the Edit Title 

option from the popup menu 
• select the fact you want to edit, click on 

the Fact Map menu and then click on the 

 button. 

12.13 Changing the view 
You can view your fact map using one of 
the following styles: 

• Fact Map – this style displays your facts 
using a diagram with links and fact icons 

• Document Outline – this style displays 
the fact information using bulleted lists 

• Treeview – this style displays the fact 
information in the form of a treeview. 

To specify which view you want to use to 
represent the fact map, click on the Fact 

Map menu and then click on the  
button and select the appropriate option. 

12.14 Brainstorming 
Brainstorming can be an effective way to 
generate lots of ideas on a specific issue, 
no matter how remote a suggestion may 
sound. You can use the Fact Mapper 
brainstorm mode to add these ideas 
quickly. 
To use brainstorming mode:  
1. Click on the Fact Map menu and then 

click on the  button. A fact is 
added to the work area. 
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2. Enter a title for the fact and then press 
Enter on your keyboard. 

3. Another fact is added to the work area 
and is automatically linked to the first 
fact. 

4. Repeat steps 2 and 3 to add further fact 
titles. All facts are linked to the first fact. 

12.15 Reorganizing the tree structure 
You can specify how you want the tree 
structure of facts displayed.  
To reorganize the tree structure: 

1. Select the main fact from which all other 
facts are linked. 

2. Click on the Fact Map menu and then 

click on the  button. You see the 
Arrange Facts window. 

3. Select one of the available 

arrangements, using the Description 
text to help you, and then click on OK. 

12.16 Exporting fact maps 
You can export a fact map to an MS 
Word document. 
To export a fact map to an MS Word 
document: 

1. Click on the File menu and then click on 

the  button. The Save As dialog box 
is displayed. 

2. Browse to the folder in the directory in 
which you want to save the fact map, 
enter a name for it in the File name text 
box and then click on Save.  
MS Word launches automatically and the 
fact map is displayed. 
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13. USING THE FACT FINDER 
You use the Fact Finder to search for 
information on the Internet using specific 
search engines. The search engines are 
categorized to help you select the one 
that will provide you with the best results. 
You access the Fact Finder by clicking 

on the  button on the toolbar. 

13.1 Setting up the default search 
engine 
To set up the default search engine: 

1. Click on the  drop down list on the 
toolbar and select Fact Finder Options. 
You see the Fact Finder Options window 
displayed. 

2. Click on Change Default. You see a 

drop down list displaying different 
categories of search engines available. 

3. Hover the mouse over a specific category 
to display search engines available within 
the category. 

4. Click on the search engine you want to 
use as your default search engine. 

5. Click on OK. 

The next time you click on the  
button, you see the Manual Text Search 
window, allowing you to search for facts 
using the default search engine. 

13.2 Searching for facts using a 
different search engine 

To search for facts using a different 
search engine: 
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1. Click on the  drop down list on the 
toolbar and select the Search using 
option. You see a drop down list 
displaying the different categories of 
search engines available. 

2. Hover the mouse over a specific category 
to display search engines available within 
the category. 

3. Click on the search engine you want to 
use to search for a word or phrase. 
You see the Manual Text Search window 
displayed, allowing you to search for 
facts using the specified search engine. 

13.3 Searching for facts using 
manual text entry 
To search for facts using manual text 
entry: 

1. Click on the  drop down list and 
select Manual Text Search. You see the 
Manual Text Search window. 

2. Enter the word or phrase you want to 
search for, in the text box provided. 

3. If required, change the default search 
engine. 

14. USING STUDY SKILLS 
You can use Study Skills to highlight text 
in MS Word and in Internet Explorer 
using different colors. You can then 
collect the highlighted text and insert it 
into a new document.  
Read&Write 9 Gold also allows you to 
summarize text in your document/web 
page using Study Skills. 
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To use Study Skills, click on the  
button until you can see the Study Skills 
buttons. The tooltip for this button helps 
you identify the appropriate toolbar. 

Alternatively, click on the  drop 
down list, select the Current Toolbar 
option and then select Study Skills. 

14.1 Using Study Skills to highlight 
text 
To use Study Skills to highlight text: 

1. Highlight text in your document/web 
page. 

2. Click on any of the following  buttons: 
• Highlight yellow 
• Highlight blue 

• Highlight green 
• Highlight pink. 
Read&Write 9 Gold highlights the text in 
the selected color. 

14.2 Collecting highlighted text 
To collect highlighted text: 

1. Highlight the text you want to collect. 
 You can highlight the text in several 

different colors if you want. 

2. Click on the  button. The Collect 
Highlights window is displayed. 

3. Set up your preferred options and then 
click on OK.  
The collected text is displayed in a new 
MS Word document. 

 Refer to ‘Using Study Skills’ in the online 
help for more information on Study Skills, 
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such as using the Collect Highlights 
window and summarizing the text. 

15. USING SCREEN MASKING  
Screen Masking allows you to ‘mask’ out 
areas of your screen and change the 
Windows system background color. This 
enables you to focus on a key area. 

To use Screen Masking, click on the  
button on the toolbar.  
The defaults set up for this facility mean 

that when you click on the  button, 
the Windows system background color 
changes, with no masking. You can 
change this functionality to suit your 
needs. 
To change Screen Masking options: 

1. Click on the  drop down list and 
select Screen Masking Options. 
The Screen Masking Options window is 
displayed. 

2. Select the type of masking you want to 
use from the Select Masking Type drop 
down list, e.g. if you select Tint 
everything except the window I'm typing 
in, the main area of focus is highlighted. 

3. Click on the Spotlight tab to enable or 
disable the spotlight functionality. If the 
spotlight option is enabled, the focal point 
moves as you move your mouse around, 
and settles on the main area of focus 
when you start to type. 

4. Click on the OK button to save your 
settings.   
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16. APPENDIX 

16.1 Accessing PDFaloud from the 
Read&Write 9 Gold toolbar 
You can access PDFaloud by clicking on 

the  button on the Read&Write 9 
Gold toolbar. A Browse dialog box is 
displayed, which allows you to locate and 
open a PDF file. Once the Adobe window 
opens, the PDFaloud toolbar is made 
available for use. 

16.2 PDFaloud update with your 
Read&Write 9 Gold 
The PDFaloud toolbar is added onto your 
Adobe Acrobat/Reader toolbar. This 

simple toolbar has various buttons to 
activate speech within the PDF 
document. 

 

 – Select to have one word spoken at 
a time or an area of selected text. You 
can choose to have text spoken by word, 
sentence or paragraph. 

 – The click and speak tool when 
pressed allows the user to point and click 
on the text which is to be spoken. 
Text will be read back with dual color 
highlighting. 

 – Speak the selection. 

 – Read the previous selection. 
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 – Pause the speech. 

 – Read the next selection. 

 – Stop the speech. 
All key features have keyboard shortcuts. 
The Options button provides access to 
the program settings: 

 
The voice pitch, speed and volume can 
be varied and a variety of male and 

female voices are available: 

 
From time to time the voice may mis-
pronounce a word. This is easily fixed by 
opening the pronunciation options menu 
and typing words into the box, as 
illustrated in the following diagram. To 
ensure proper pronunciation, simply type 
the word phonetically into the second text 
box and save the changes. 
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17. GLOSSARY 
This chapter discusses terms used in this 
guide which might be unfamiliar to you. 
Consonant 
A letter or group of letters that represents 
a speech sound. 
Custom dictionary 
Read&Write 9 Gold has the facilities for 
you to customize an existing dictionary 

by adding rare words that you use. The 
result is called a custom dictionary. 
Dictionary 
A dictionary is a reference document 
which groups together words with the 
same or similar meanings. 
Dyslexic phonetic errors 
Dyslexic phonetic errors arise from 
spelling words as they sound rather than 
how they should be spelt. For example, a 
phonetic mis-spelling of photograph 
might be fotograf. 
Homophones 
Homophones are words that are 
pronounced the same but spelt 
differently. For example, bred and bread. 
Inflection 
The change in a word to mark such 
distinctions as case, gender, number, 
tense, mood etc. For example, ‘happier’ 
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and ‘happiest’ are inflections of the word 
‘happy’. 
Partial word match 
Partial word match is a Read&Write 9 
Gold facility that can suggest words to 
complete a word fragment. 
Phoneme equivalents 
Phoneme equivalents are 
representations of phonetic spellings 
using the English alphabet. 
Phonetic alphabet 
This is based on the conventional 
alphabet, but is different because 
characters are represented phonetically. 
Phonetic map 
The phonetic map is a method used by 
Read&Write 9 Gold to group together 
letters and groups of letters that can 
sound the same. For example, ph is 
grouped with f. 

SAPI 
Speech Applications Programmers 
Interface (SAPI) is the standard voice 
application for Microsoft applications. 
Strict Consonant 
A letter that represents a speech sound 
excluding vowels. 
Syllable 
A part of a word that is spoken as one 
sound. 
Synonym 
A word that means exactly or nearly the 
same as another word in the same 
language.  
Word Prediction 
Word Prediction is a Read&Write 9 Gold 
facility that can predict words to follow a 
word that you are typing. 
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